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Introduction

RAS Manager 4.0
Overview: RAS Manager is a client/server application that provides full-time 
control, real-time monitoring, and session-by-session accounting for RAS 
connections. RAS Manager works with the Windows NTTM Remote Access 
Service (RAS) to tailor dial-in connections to your organizational needs. With 
its ability to automatically enforce your RAS management policies, RAS 
Manager lets you accomplish more with your existing resources.

This introduction describes the installation process and any problems that may 
occur.  This manual (along with the on-line help guide) provides 
comprehensive information for all aspects of RAS management, a thorough 
definition of terms,  and step-by-step directions for using the RAS Manager 
program. 

List of Materials
Please verify that you have the following:

· RAS Manager installation CD-ROM
· Quick Start guide 
· Registration forms

If you’re missing any of the items listed above, or have a defective CD-ROM, 
contact NTP Software Support at 603-626-0986 immediately.

RAS Manager™ is a trademark of NTP Software. Windows NT™, Windows 95™ and Windows for 
Workgroups™ are trademarks of the Microsoft Corporation. All rights reserved.
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System Requirements
The network server must meet the following minimum requirements to install 
and run RAS Manager:

Operating System:
· To install the Service:  Windows NT 4.0 or higher 
· To install the Administrator:  Windows NT 3.51 or higher

Software:
· Microsoft Remote Access Service (RAS) installed and properly configured

Hardware:
· An x86 based server with a double speed CD-ROM drive

Installation Procedure 
Choose the NT server you wish to install the RAS Manager service on. If the 
RAS service has not been installed or configured on this machine, you must do
so before installing the RAS Manager service. 

The steps below outline the complete installation process for RAS Manager 
4.0. Detailed installation information is included in the paragraphs that follow.

1. Install the RAS Manager service or the RAS Manager administration 
program.

2. Verify installation by starting the service.
3. Restart the Windows NT RAS Access Server service.

The RAS Manager CD-ROM contains one setup program for both the service 
and the RAS Manager administration program.

Note: You must have administrative network access to grant or modify 
RAS permissions with RAS Manager.
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Installing RAS Manager 
This section describes how to install RAS Manager.

Note:  If you have more than one RAS server, choose one to be the 
primary RAS server.  The primary RAS server hosts the RAS Manager 
data store.  You must install RAS Manager on the primary RAS server 
first.

To install RAS Manager, do the following:

1. Logon to a Windows NT server using an account with Administrator 
privileges.

2. Insert the CD-ROM containing RAS Manager into a CD-ROM drive.
3. Run the RAS Manager installation program, setup.exe.  The Welcome 

Screen appears.
4. Click Continue.  The Installation Screen appears.
5. Click Install.  The License Agreement Screen appears.
6. Click Accept to continue.  The Name and Organization dialog box 

appears.
7. Enter a name in the Name field and the name of your organization in the 

Organization field.  The Installation Options screen appears.
8. Select RAS Manager Service to install the service and select 

Administrator to install the Administrator program.  

Þ The Service Account field, the Account Password field and the 
Confirm Password field discussed in the next three steps 
only appear if you chose to install the RAS Manager service 
in the previous step.

Þ
9. Enter a domain and name or use the default in the Account ID field.  This 

is the user account that is used to run the RAS Manager service.
10. Enter the password in the Account Password field and again in the 

Confirm Password field.
11. Click Service Startup Type is ‘Automatic’ if you want the service to 

start automatically after reboot; otherwise, the startup is manual.
12. The Site Name screen appears.

If this is the primary RAS Manager server, you must create a new site.
For all other servers, choose Join an existing site.
When joining an existing site, enter the name of the primary RAS 
Manager server.
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For a new site, enter the name that you want to use to store the RAS 
Manager data files.  When setup completes, you must create a share 
name with the same name you used for the site name.  RAS Manager 
stores the data files in the share name.  Give the account ID user to 
run the RAS Manager service full permissions to this share name.

13. Setup now copies the required files and updates your workstation.
14. When the installation is complete, setup offers you the chance to view the 

Readme file.  Click Yes or No.

If you installed the Administrator’s Program, the setup program installs a RAS 
Manager for Domains program icon in the Administrative Tools Group.

Initializing RAS Manager Service
You must restart the Windows NT Remote Access Server service and the RAS 
Manager service. To restart the services, do the following:

1. Open Control Panel and double-click the Services icon.
2. Select the Remote Access Server service. Click Start. 
3. Select the RAS Manager Service.  Click Start.

Uninstalling RAS Manager
You must first stop the Windows NT Remote Access Server service and the 
RAS Manager service before uninstalling RAS Manager.

To uninstall RAS Manager do the following:

1. Logon to a Windows NT server using an account with Administrator 
privileges.

2. Insert the CD-ROM containing RAS Manager into a CD-ROM drive.
3. Run the RAS Manager installation program, setup.exe.  The Welcome 

Screen appears.
4. Click Continue.
5. Choose Remove All to uninstall all components.
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Reinstalling RAS Manager and Adding or Removing 
Components
To reinstall RAS Manager or add or remove RAS Manager components, do the
following:

1. Logon to a Windows NT server using an account with Administrator 
privileges. 

2. Insert the CD-ROM containing RAS Manager into a CD-ROM drive.
3. Run the RAS Manager installation program, setup.exe.  The Welcome 

Screen appears.
4. Click Continue.  The Installation Screen appears.
5. Click Install.  The License Agreement Screen appears.
6. Click Accept to continue.  The Name and Organization dialog box 

appears.
7. Enter a name in the Name field and the name of your organization in the 

Organization field.  The Installation Options screen appears.
8. Select RAS Manager Service to install the service and select 

Administrator to install the Administrator program.  
9. Click the items you want to install; clear the items you want to remove.

Þ The Service Account field, the Account Password field and the 
Confirm Password field discussed in the next three steps 
only appear if you chose to install the RAS Manager service 
in the previous step.

Þ
10. Enter a domain and name or use the default in the Account ID field.  This 

is the user account that is used to run the RAS Manager service.
11. Enter the password in the Account Password field and again in the 

Confirm Password field.
12. Click Service Startup Type is ‘Automatic’ if you want the service to 

start automatically after reboot; otherwise, the startup is manual.
13. The Site Name screen appears.

If this is the primary RAS Manager server, you must create a new site.
For all other servers, choose Join an existing site.
When joining an existing site, enter the name of the primary RAS 
Manager server.
For a new site, enter the name that you want to use to store the RAS 
Manager data files.  When setup completes, you must create a share 
name with the same name you used for the site name.  RAS Manager 
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stores the data files in the share name.  Give the account ID user to 
run the RAS Manager service full permissions to this share name.

13. Setup now copies the required files and updates your workstation.
14. When the installation is complete, setup offers you the chance to view the 

Readme file.  Click Yes or No.

If you installed the Administrator’s Program, the setup program installs a RAS 
Manager for Domains program icon in the Administrative Tools Group.
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Installation Problems
RAS Manager is an easy-to-use utility with few failure modes. Most 
installation problems stem from improper network configurations or access. 

For installation problems, first verify the following: 

· You have logged on with appropriate network administrative rights and 
password

· The RAS service is installed and properly configured

Re-install RAS Manager. If the problem persists, contact NTP Software at 603-
626-0986. Leave a message and phone number when prompted. Someone from
Software Support will return your call as soon as possible. Or you can contact 
NTP Software Support on-line at: http://www.ntpsoftware.com; or email to 
support@ntpsoftware.com. Please have the following information available:

· Your RAS Manager serial number
· Windows NT version and the list of services you are currently running
· RAS Manager Event log information
· The specific problem(s) requiring assistance

Using RAS Manager’s On-line Help
RAS Manager has extensive on-line help. Select Help from the main menu or 
contact NTP Software Support on-line at: http://www.ntpsoftware.com; or 
email to support@ntpsoftware.com for additional information.
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Preparing Remote Users to Receive Warning 
Messages 
RAS Manager notifies remote users when their logon time limits (as set in 
RAS Manager) are close to expiring. No additional software is required to 
configure your remote user's machines. To receive custom messages, the 
remote users must have the following:

· Valid network ID and password
· RAS dial-in permission - set in RAS Manager or NT’s Remote Access 

Admin 
· Winpopup for Windows for Workgroups or Windows 95 installed and 

properly configured 
· Messenger Service for Windows NT installed and properly configured 

Configuring Workstations
See Chapter 3, “Configuring Remote Workstations To Receive 
Warning Messages.” 
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Chapter 1 RAS Manager Overview

RAS Manager is a powerful tool that works with Microsoft’s Remote Access 
Service (RAS) for Windows NT. This chapter introduces RAS Manager, and 
provides detailed descriptions of RAS Manager’s terms, operations, and 
inherent security features. 

Remote Access Service (RAS) 
Whether your personnel are located on a plane to Paris—or in a basement in 
Boston, Microsoft's RAS gives users with phone lines the ability to logon to 
their home network, regardless of location. Your people have access to the 
network resources as if they were still in the office. 

Why Manage RAS?
Imagine that you are the Network Administrator for an organization (or an 
Internet Service Provider) with 3,000 remote users. Now imagine that they all 
try to establish RAS connections to the network simultaneously. You know 
what happens next; unless you have 3,000 phone lines and a bunch of RAS 
servers, only a few users get through. If you could distribute the RAS calls 
throughout the day, and limit the amount of time each caller remains 
connected, your network could support more users with the same resources. 

Even if you have no problems with RAS access now, the demand for RAS is 
certain to grow. Downsizing, decentralizing, and telecommuting are facts of 
business life. They all create demand for remote access to your network. If 
you’re an ISP, you know about surging demand. The need to manage RAS 
resources is certain.

RAS Manager Functions 
RAS Manager lets you:

· Establish and automatically enforce a RAS management policy
· Generate basic RAS use accounting information
· Allow or deny RAS user access
· Control the length of RAS sessions
· Specify RAS servers to connect to
· Specify network Peak hours and off-hour time limits
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· Specify daily, weekly, and monthly time limits
· Establish global logon times to allow RAS connections
· Modify any default setting to meet individual user requirements
· Create custom warning messages that inform RAS clients of 

impending disconnection

Using RAS Manager
RAS Manager’s power lies in it’s simplicity and flexibility. RAS Manager 
works with Windows NT, managing all incoming lines to your RAS server; 
ISDN; X 400; and asynchronous modem lines. By monitoring and controlling 
these incoming lines, RAS Manager organizes access to your RAS server. This
organization time-shares incoming RAS connections and optimizes server 
availability. But first, you have to provide the RAS Manager program with the 
following information: which users are allowed access, which servers they can 
connect to; and the time limit of their RAS sessions. 

To do this, configure global and individual settings. The global settings, or 
system preferences, are defaults that apply to all RAS users granted RAS dial-
in access. Individual settings, or user preferences, can be set on any individual 
with RAS permissions. Once set, user preferences override default system 
preferences. For additional information on setting system and user preferences ,
see Chapter 3, “Setting System Preferences” and “Setting User Properties.”

RAS Manager is tightly integrated with Windows NT. All RAS Manager 
events are posted to NT’s application log when a RAS user connects, 
disconnects, or is forced off the server. This information provides a quick 
reference that identifies RAS users and helps pinpoint problems when 
troubleshooting.

The terms defined in this chapter are used throughout this manual. Please 
familiarize yourself with RAS Manager’s global and individual settings. Then 
read the detailed descriptions that follow.

Global and individual settings for RAS Manager:

· System Preferences. Default global settings that apply to all
· User Properties. Individual settings assigned to RAS users.
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System Preferences Defined
These are global properties that set network Peak hours and Off hours, time 
limits, logon hours and connection times, and custom warning messages that 
remind RAS users of impending disconnection. For additional information, see
Chapter 3, “Setting System Preferences” and “Setting Warning Messages”. 

The following terms describe global system preferences:

Concurrent Sessions.  The number of concurrent user logons through RAS 
with the same user id. 

Peak Hours and Off Hours. Peak hours are the hours (day or night) that your 
NT network has the greatest number of clients connected, using the greatest 
amount of network resources. RAS Manager sets network peak hour defaults 
from 9 A.M. to 5 P.M. during setup. Off hours are the hours when network 
demand is at a minimum. You can tailor these settings to meet the demands of 
your organization in the Set Peak Hours dialog box. 

Peak Hours and Off Hour Time Limits. Time limits (in minutes) that you set, 
and are imposed globally on RAS connections, during peak hours and off 
hours. Set global peak hours and off hour time limits in the Set System 
Preferences dialog box.

Daily, Weekly, and Monthly Time Limits Time limits that you set daily, 
weekly, or monthly and are imposed globally on RAS connections.  Set daily, 
weekly, and monthly time limits in the Set System Preferences dialog box.

Default Logon Hours. The Default Logon Hours setting defines when RAS 
users are allowed to connect to a RAS server. Setting the Default Logon 
Hours lets you control when the maximum RAS load is likely to occur, and 
prevent that load from conflicting with other network activities. 

Default Logon Servers. During installation, RAS Manager sets defaults that 
allow all RAS users access to all network RAS servers. You can elect to 
restrict access to specified servers.

Warning Messages. RAS Manager lets you set up to three custom warning 
messages that warn your remote users of impending disconnection. 
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User Properties Defined
You can tailor user properties to each individual RAS client. As previously 
stated, once new properties are set in the User RAS Properties dialog box, 
they override default system preferences. If you require additional information 
on setting User RAS Properties, see Chapter 2, “Setting User RAS Properties.” 

The following terms describe user properties:

Concurrent Sessions.  The number of concurrent user logons through RAS 
with the same user id. 
 
Grant Dial-in Permission:  Grants dial-in permissions without opening NT’s 
Remote Access Admin. Program.

Peak hours and Off-Hour Time Limits. Time limits (in minutes) imposed on 
an individual’s RAS connection. Setting time limits for each RAS user gives 
everyone a fair shot at the network. This prevents careless users from tying up 
your RAS lines and effectively shares your network resources. Set individual 
Peak hours and off-hour time limits in the User RAS Properties dialog box.

Daily, Weekly, and Monthly Time Limits Time limits that you set daily, 
weekly, or monthly and are imposed globally on RAS connections for each 
RAS user.  Set daily, weekly, and monthly time limits in the User RAS 
Properties dialog box.

Individual Logon Hours. You can override the default logon hours to meet 
individual RAS user needs. If a user has RAS dial-in permissions, you can set 
individual Logon Times in the User RAS Properties dialog box. This 
overrides default logon hours for the user. If you grant a new user RAS 
permissions without specifying logon hours, then the global defaults are in 
effect. 

Logon Access to Specified Servers. This management feature lets you organize
your RAS clients by server. 
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RAS Manager As a Network Security Tool
Your information is precious, and it’s your responsibility to safeguard that 
information. RAS Manager has features that can enhance the security of your 
network by imposing restrictions on remote network access. You can choose to
impose global or individual access limitations. 

Inherent security features in RAS Manager:

· Restricting dial-in permissions
· Restricting logon access to specified servers 
· Restricting logon access to specified hours
· Restricting individual dial-in time limits

Combine these security features to enhance your current network security 
policies for remote users. Read on for a detailed description of each feature.

Restricting Dial-in Permissions 
This feature is performed on an individual level. To dial-in remotely, the user 
must have dial-in permissions. RAS Manager lets you quickly remove dial-in 
permissions (one checkbox in the User RAS Properties dialog box), without 
affecting individual, pre-set user properties. Keep in mind that restricting dial-
in permissions affects the user’s next RAS session. If a user is currently logged 
on, restricting dial-in permissions will not kick them off the system. 

Restricting Logon Access To Specified Servers 
This security feature lets you protect information by only allowing users RAS 
access, to specified servers. 
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Restricting Logon Access To Specified Hours 
This feature is similar to setting global logon times. Each user has different 
responsibilities—and network requirements. Use this feature to limit the hours 
of the day an individual can connect to a RAS server. 

Restricting Individual Dial-in Time Limits 
Limiting individual dial-in time limits ensures that users are working the whole
time they’re connected. Time limits create a sense of urgency, reminding users
that time is limited, and to make the most of it. At the organizational level, 
time limits give everyone a fair shot at the network. 
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Chapter 2  Navigating the RAS
Manager Administration

Program

Overview: This chapter is designed for you to gain familiarity with RAS 
Manager Administration program menus and commands. This chapter will 
explain:

· RAS Manager’s menus and commands
· Using the Toolbar
· Using the Status Bar
· Using on-line help

Note: RAS Manager follows general Windows guidelines for navigation: 
The terms Click, and Select mean “place the mouse cursor over the 
menu item or button and press or “click” your primary mouse button.” 
Boldface items in descriptive text emphasize action or program 
components that require attention. If you require additional information, 
please consult your Windows documentation.

RAS Manager Main Window
RAS Manager’s document window displays all users in the selected domain. 
When RAS Manager first starts, the title bar displays the domain from which 
your workstation resides. . The toolbar provides shortcuts to all menu 
commands, and the status bar displays detailed information on menu 
commands and options.  

Using RAS Manager’s toolbar or pull-down menu commands, you can:

· Select users from different domains
· Grant or remove RAS permissions 
· Set dial-in time limits on an individual basis
· Set global options for all RAS users
· Set custom time remaining on-line messages
· Consult on-line help
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Figure 1 RAS Manager Main Window 

RAS Manager Main Window Components

Title Bar
Displays the selected domain name.

Main Menu 
Set or modify default system preferences and user RAS permissions:

User menu Set or modify user permissions, select new 
domain
Options menu Set or modify system preferences
Tools menu Export and Clear RAS Manager statistics
View menu Select Status Bar and Toolbar for viewing
Help menu Access the RAS Manager on-line help 

guide

Toolbar 
Shortcuts to all Main menu commands. You can optionally select not 
to view the toolbar in the View menu. See “Using the Toolbar” in this
chapter for additional information.
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Document Window 
Displays a list of all users in the selected domain (that appears in the 
Title Bar):

Username is the name used by Windows NT to identify the 
account. Full name contains the full name of the user 
account, but may be blank. Description provides additional 
account information when available.

Status Bar
Displays additional information when you place your mouse pointer 
over a toolbar icon or menu item. You can optionally select not to 
view the status bar in the View menu.

Menu Commands
The following sections describes the commands found on the Options Menu, 
the User Menu, the Tool Menu, and the View Menu.

Options Menu Commands
You set the system preferences using the Options Menu commands. Once 
established, these preferences become the default settings when new users are 
granted RAS permissions. You can set or modify default connection times, 
system peak hours and off hours, and customize warning messages. 

Note:  System preferences, peak hours, and warning messages are set 
for each domain; therefore, you can set different values for each domain.

Menu Item Description
Set System Preferences. . . Opens the System Preferences dialog 

box. Set Default Logon Hours, time limits
and Logon Servers for the specified 
domain. 

Set Peak Hours. . . Opens the Set Peak Hours dialog box. Set
default system peak hours and off hours 
for the specified domain.

Set Warning Messages. . . Allows administrators to customize time 
remaining on line warning messages for 
the specified domain. You may customize 
up to three messages to inform RAS users 
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of remaining on-line time (as set in the 
User RAS Properties dialog box).

User Menu Commands 
Use this menu to display and modify User RAS Properties. First, select a user
in the main window. Then select a menu option to modify their properties. For 
additional information on setting user properties, see “Setting User RAS 
Properties” in Chapter 3.

Menu Item Description
Properties. . . Displays the User RAS Properties dialog box with 

individual user logon time limits and dial-in 
permissions. Double-clicking on a user name will 
also display the User RAS Properties dialog box.

Reset Properties. . . Resets selected user properties to default settings 
while retaining dial-in permissions.

Disable... Removes dial-in permissions.
Select Domain. . . Displays the Select Domain dialog box from User 

Manager. Lets you choose a domain to select user 
accounts.

Exit. . . Terminates the RAS Manager program.

Using the User Menu to Change Default Settings
You can change default settings, such as Peak hours and off-hour time limits, 
on an individual basis in the User Properties dialog box. When you change 
default settings, the new settings apply automatically until they are changed, or
reset using the Reset Properties… command in the User menu.
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Tool Menu Commands 
The Tool menu commands export statistics in delimited text format or dBase 
format.

   Menu Item Description
   Export Session Stats... Exports session statistics in delimited text 
                                                         format or dBase format.
   Export Hourly Port Stats... Exports hourly port statistics in delimited 
                                                          text format or dBase.
   Export Daily Port Stats... Exports daily port statistics in delimited test
                                                          format or dBase.

View Menu Commands 
Turns the optional toolbar and Status Bar on and off. For additional 
information, see, “Using the Toolbar” and “Using the Status Bar” later in this 
chapter.

Using the Toolbar 
The toolbar provides shortcuts to all available menu items, grouped by menu 
topic. Hold your mouse cursor over any toolbar button and a mini help box will
display the button name. If you have the Status Bar enabled, a description of 
the button will appear on the bottom of the RAS Manager window. 

Figure 2 RAS Manager Toolbar Buttons

User Menu Toolbar Shortcuts 
Properties - Opens the Set User Properties dialog box. Shortcut to 
User, Properties…
Reset Properties - Resets selected user properties to default settings. 
Shortcut to User, Reset Properties...
Disable - Removes user dial-in permissions. Shortcut to User, 
Disable…
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Select Domain - Opens the Select Domain dialog box. Shortcut to 
User, Select Domain…

Options Menu Toolbar Shortcuts 
Preferences - Opens the Set System Preferences dialog box. Shortcut 
to Options, Set System Preferences…
Set Peak Hours - Opens the Set Peak Hours dialog box. Shortcut to 
Options, Set Peak Hours...
Warning Messages - Opens the Set Warning Messages dialog box. 
Shortcut to Options, Set Warning Messages…

Help Menu Toolbar Shortcuts 
Opens the RAS Manager on-line help guide.

Viewing or Hiding the Toolbar
The toolbar appears by default, but you can optionally select to hide it:

1. Click View on the main menu. A check mark in front of the 
Toolbar menu command indicates the toolbar is selected. If 
the toolbar is not visible, click Toolbar.

2. Click View, Toolbar again to remove the check mark and hide 
the toolbar.
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Using the Status Bar 
The Status Bar provides detailed descriptions of menu and toolbar items. Place
your mouse cursor over a menu or toolbar item and a description of that item 
appears in the Status Bar at the bottom of the RAS Manager main menu. 

Figure 3 Status Bar

Viewing or Hiding the Status Bar 
By default, the Status Bar is enabled. You may select to hide it:

1. Click View on the main menu. A check mark in front of the 
Status Bar menu command indicates the Status Bar is 
selected. If the Status Bar is not visible, click Status Bar.

2. Click View, Status Bar again to remove the check mark and 
hide the Status Bar.

Using On-line Help
RAS Manager has an extensive on-line help guide. You access on-line help 
through the Help menu. You have three options:

· Contents - Brings you to the Table of Contents page of the Help 
file.

· Search for Help On - Opens the Index page of the Help file. 
Type in the first few letters of the topic you wish to search 
for help on. If the topic is available, it will display in the 
window. Click Display to view the information.

· How To Use Help - Opens the Windows NT Help guide. Use as a
resource for accessing and using all help files.

· About - Displays a dialog box with product serial number and 
revision information. Have this information handy when 
contacting technical support.
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Chapter 3 Using RAS Manager

Overview:. This chapter explains the following:
 

· Setting or modifying default system preferences
· Setting or modifying user RAS properties
· Configuring remote workstations to receive warning messages
· Exporting session statistics, hourly port statistcs, and daily port 

statistics

Setting System Preferences 
System preferences are default values that apply when a user is granted RAS 
permissions and no individual properties are set for that user. There are five 
basic system preference default settings:

· Set Default Time Limits
· Set Default Logon Hours
· Set Default Logon Server Access  
· Set Default Peak Hours and Off Hours
· Set Custom Warning Messages

Note:  System preferences, peak hours, and warning messages are set 
for each domain; therefore, you can set different values for each domain.

For additional information on system preference definitions, see  “System 
Preferences Defined,” in Chapter 1.
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Setting Default Time Limits
To set Default Time Limits:
(Tool Bar shortcut)

1 Click Options, Set System Preferences… from the RAS Manager menu.
The Set System Preferences dialog box appears.  

2
3

Figure 4 Set System Preferences Dialog Box

4
5 Enter the default time in minutes for each session and periodic limit field.
6 Set the Session Limits as follows:

7 Fill in Concurrent Sessions with the number of times a user can 
dial in concurrently.

8 Fill in the Peak Hours Time Limit with the number of minutes, on 
a per session basis, you want to allocate to each user during peak 
hours.

9 Fill in the Off Hours Time Limit with the number of minutes, on a 
per session basis, you want to allocate to each user during off hours.

10 Note:  You can define peak hours and off hours from the 
Options menu, the Set Peak Hours... submenu.
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11    Set the Periodic Limits as follows:
12Fill in the Daily Time Limit, the Weekly Time Limit, and the 

Monthly Time Limit with the number of minutes you want to 
allocate to each user on a daily, weekly, and monthly basis.

13Click OK.
Note:  When setting the system default time limit, choose a time limit (in 
minutes) that provides enough time for your average remote user to 
adequately perform their duties. Entering a zero in a time limit field 
provides unlimited access.

Note: System preferences, peak hours, and warning messages are set 
for each domain; therefore, you can set different values for each domain.
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Setting Default Logon Hours
14This procedure is also a security feature: Restrict Logon Access To 

Specified Hours.
15Use the RAS Logon Hours dialog box to set the default days and hours 

during which all users granted RAS dial-in permissions can connect to a 
server. 

16
17To set or restrict Logon Hours:

(Tool Bar shortcut)
1. Click Options, Set System Preferences. . . from the RAS Manager menu. 

The Set System Preferences. . . dialog box appears.
2. Click Hours. The RAS Logon Hours dialog box appears.
3. Enter the logon time in each field for the day of the week. You may set up 

to three different logon periods per day.

Figure 5 RAS Logon Hours Dialog Box

18For example:
19 Day From To From To From To

Sunday 9 17
Monday 9 17

20 Tuesday 9 18 22 24
21
22Note: All times are set with 24-hour clock settings. This example 

sets logon hours between 9 A.M. to 5 P.M. on Sunday and Monday, 
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and 9 A.M. to 6 P.M on Tuesday. An additional logon period has been 
added to Tuesday’s schedule, between 10 P.M. to midnight. Entering
all zeroes or leaving the boxes blank provides unlimited logon 
access.

23
4. Continue setting logon hours for each day of the week.
5. When satisfied with your Logon Hours settings, click OK.
6. Click OK to close the Set System Preferences. . . dialog box.
7. Clicking Default  sets the session or its periodic limits to the system 

defaults.

24Note: System preferences, peak hours, and warning messages are
set for each domain; therefore, you can set different values for each
domain.

Copyright Ó 1997 by NTP Software.  All rights reserved.30



Setting Default Logon Server Access
This procedure is also a security feature: Restrict Logon Access To Specified 
Servers.
Use the Logon RAS Workstations dialog box to set the default server(s) to 
which all users (that are granted RAS permissions) can connect. 

 (Tool Bar shortcut)
25Click Options, Set System Preferences. . . from the RAS Manager 

menu. The Set System Preferences dialog box appears.
26Click Logon To. The Logon RAS Workstations dialog box appears.
27

28

Figure 6 Logon RAS Workstations Dialog Box

29Slect User May Logon To These Computers Offering the RAS 
Service.

30Enter the computer names in the spaces provided. You may enter up to 
eight different computers for each user account.

31Select User May Logon To All Computers Offering RAS Service if 
you want the user to be able to access all computers offering RAS 
Service.
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32Clicking Set To Defaults sets the session to the system defaults.
33Click OK to return to the Set System Preferences dialog box.
34Click OK to save your settings and close the dialog box.
35Note:  System preferences, peak hours, and warning messages are

set for each domain; therefore, you can set different values for 
each domain.
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Setting Peak Hours and Off Hours 
Use the Set Peak Hours dialog box to set the hours during which your network
is operating at its peak. RAS Manager uses this time setting as a reference, and
limits user logon time during peak hours to the most recently saved settings in 
the User RAS Properties dialog box. 

The Peak Hours default is set at 9 A.M. to 5 P.M. during software installation, 
but you can tailor the settings to your organization's requirements.

To set Peak Hours:
(Tool Bar shortcut)

36Click Options, Set Peak Hours… from the RAS Manager menu. The 
Set Peak Hours dialog box appears.

37In the Set Peak Hours dialog box, enter the time in each field for the day
of the week.  You may set up to three different peak hour settings per 
day.

38

39

      Figure 7 Peak Hours Settings in the Set Peak Hours Dialog Box

40
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41For example:
42 Day From To From    To     From    To
43 Sunday 9 17
44 Monday 9 17
45 Tuesday 9 17
46
47Note: All times are set on a 24-hour clock. This example sets peak 

hours between the hours of 9 A.M. to 5 P.M. on Sunday and Monday, 
and 9 A.M. to 6 P.M. on Tuesday. 

48Continue setting peak hours for each day of the week.
49When satisfied with your Peak Hours settings, click OK.
50
51Note:   System preferences, peak hours, and warning messages 

are set for each domain; therefore, you can set different values for 
each domain.
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Setting Warning Messages 
The Set Warning Messages dialog box allows you to create custom messages 
for your remote users. When connected, these messages inform your RAS 
clients of the amount of time remaining in their RAS session. You may 
customize up to three “warning” messages that notify users of impending 
disconnection.

To set Warning Messages:
(Tool Bar shortcut)

52Click Options, Set Warning Messages… from the RAS Manager menu. 
The Set Warning Messages dialog box appears.

53

54

Figure 8 Set Warning Messages Dialog Box

55
56Select the Message 1, 2, or 3 Send Popup check box(s). Message priority

is set by the number placed in the Minute(s) left field. A higher number 
in minutes will display the relevant message first, and the lowest number 
corresponds to the last message displayed before the user's RAS 
connection is terminated.

57Enter the time remaining in minutes for each message.  
58Enter the message you wish displayed. You have up to 255 characters per

message to create your custom warning messages.
59Click OK.

Note:  System preferences, peak hours, and warning messages are set for each 
domain; therefore, you can set different values for each domain.
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Setting User RAS Properties 
User RAS Properties such as dial-in permissions, Peak hour and off hour time 
limits, and logon access times are all set in the User RAS Properties dialog 
box. To set properties, you must first select a user account in the RAS 
Manager window. A user account can be selected from the domain that RAS 
Manager opened with, or from another domain that has the proper trust 
relationships established. See “How to Select a Domain” later in this chapter 
for additional information. For additional information on establishing domain 
trust relationships, consult your Windows NT documentation.

Figure 9 User RAS Properties Dialog Box

Note: When you’re finished setting user account properties, click OK to 
close the User RAS Properties dialog box and save the settings for the 
specified user. If you select Cancel, User Properties will default to the last 
saved entry.
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Setting User Time Limits 
To set User Time Limits:
(Tool Bar shortcut)

60Click User Properties... from the RAS Manager’s Main menu.  The 
User RAS Properties dialog box appears.

61Enter the time in minutes for each session and periodic limit field.
62Set the Session Limits as follows:

63Fill in Concurrent Sessions with the number of times a user can 
dial in concurrently.

64Fill in the Peak Hours Time Limit with the number of minutes, on 
a per session basis, you want to allocate to each user during peak 
hours.

65Fill in the Off Hours Time Limit with the number of minutes, on a 
per session basis, you want to allocate to each user during off hours.

66 Note:  You can define peak hours and off hours from the Options 
menu, the Set Peak Hours... submenu.

67    Set the Periodic Limits as follows:
68Fill in the Daily Time Limit, the Weekly Time Limit, and the 

Monthly Time Limit with the number of minutes you want to 
allocate to each user on a daily, weekly, and monthly basis.

69Time Remaining is the number of minutes remaining for the periodic 
time limits.

70Click Set to Defaults to set the session or its periodic limits to the system
defaults.

71Click OK.
72

Note:
When setting the time limits, choose a time limit (in minutes) that provides 
enough time for your average remote user to adequately perform their duties. 
Entering a zero in a time field provides unlimited access.

For additional information on User Properties, see “User Properties Defined,” 
in Chapter 1.

Selecting a User Account 
73Double-click the user account (see figure 4-5) you wish to set, or select 

the user account and click Properties from the User menu. The User 
RAS Properties dialog box appears. You can set all user properties here.
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74
75

         Figure 10 RAS Manager Main Window with a User Account Selected

76
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Granting Dial-in Permission 
This procedure is also a security feature: Restrict RAS Dial-in Permissions

To grant or restrict Dial-in Permissions: 
(Tool Bar shortcut)

77Click User, Properties. . .  from the RAS Manager menu. The User RAS
Properties dialog box appears.

78

79

     Figure 11 User RAS Properties Dialog Box with Dial-In Permission
Selected

80
81To grant dial-in permission, select Grant dial-in permission to user in 

the User RAS Properties dialog box. 
82Continue setting additional User Properties or click OK to save the 

setting and close the dialog box. 
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 Managing User Logon Hours 

83This procedure is also a security feature: Restrict Logon Access To 
Specified Hours.

84Use the Logon Hours dialog box to set or restrict the days and hours 
during which a user can connect to a server. 

85
86To set or restrict Logon Hours:

(Tool Bar shortcut)
87Click User, Properties… from the RAS Manager menu. The User RAS 

Properties dialog box appears.
88Click Hours. The RAS Logon Hours dialog box appears.
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89

90

Figure 12 RAS Logon Hours Dialog Box

91
92Enter the preferred user logon time in each field for the day of the week. 

You may set up to three different logon periods per day.
93For example:
94 Day From To From To  

Sunday 9 17
95 Monday 9 17
96 Tuesday 9 18 22 24
97
98Note  : All times are set on a 24-hour clock. This example sets individual 

logon hours between 9 A.M. to 5 P.M. on Sunday and Monday, and 9 A.M. to
6 P.M on Tuesday. An additional logon period has been added to 
Tuesday’s schedule, between 10 P.M. to midnight.

99
100Continue setting logon hours for each day of the week.
101When satisfied with your Logon Hours settings, click OK.
102Click Set To Defaults to set the logon hours to the system defaults.
103Click OK to close the User Properties dialog box.
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Restricting User Logon Access to Specified Servers
This procedure is also a security feature: Restrict Logon Access To Specified 
Servers
Use the Logon RAS Workstations dialog box to restrict the servers to which a
user can connect. 

To restrict User Logon Access:
(Tool Bar shortcut)

104Click User, Properties. . . from the RAS Manager menu. The User 
Properties dialog box appears.

105Click Logon To. The Logon RAS Workstations dialog box appears.
106

107

   Figure 13 Logon Workstations Dialog Box

108In the Logon To dialog box, select User May Logon To These 
Computers Offering the RAS Service.

109Enter the computer names in the spaces provided. You may enter up to 
eight different computers for each user account.

110Click Set To Default to set the specified servers to the system defaults.
111Click OK to return to the User RAS Properties dialog box.
112Click OK to save your settings and close the dialog box.

Disabling User Properties 
This feature is a menu item shortcut to the “Grant dial-in permission to user” 
selection in the User RAS Properties dialog box. When you disable a user’s 
properties, you simply remove their dial-in permissions, keeping their 
individual user settings intact. 
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To Disable User Properties:
(Tool Bar shortcut)
1. Click User, Disable User Properties from the RAS Manager main menu.
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Selecting A Domain 
RAS Manager lets you grant RAS permissions to users in different domains, 
provided you have the proper trust relationship established with the domain. 
See your Windows NT documentation for information on establishing trust 
relationships across multiple domains.

To select a different domain:
(Tool Bar shortcut)

113Click User, Select Domain… from the RAS Manager menu. The Select
Domain dialog box appears.

114

115

Figure 14 Select Domain Dialog Box

116
117Choose a domain from the list in the Select Domain list box, or type a 

domain name in the Domain text box.
118Click OK to return to the RAS Manager main window. User names for 

the newly selected domain will appear in the main document window. 
119
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Reseting User Properties 
This feature resets the selected user properties to system defaults, without 
affecting dial-in permissions. 

To Reset User Properties:
(Tool Bar shortcut)
1. Click User, Reset from the RAS Manager main menu.

Configuring Remote Workstations To Receive 
Warning Messages 

Warning messages are displayed differently, depending on the workstation 
platform. Windows for Workgroups and Windows 95 workstations require 
Winpopup, a program included with both versions of Windows. Winpopup 
must be running to receive custom messages. Additionally, you can 
customize the method in which the workstation is notified using Winpopup. 
Windows NT workstations require that the Messenger service be started and 
properly configured. For additional information on customizing Winpopup, 
or Windows NT Messenger Service, consult your Windows documentation.

The following sections provide specific setup information for all your remote
client workstations.
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Configuring for Windows for Workgroups 

120Open the Control Panel from the Main program group.
121Double click the Network icon. The Microsoft Windows Network 

dialog box appears.
122Under Options, click Start Up. The Startup Settings dialog box 

appears.
123Select Enable Winpopup. 
124Choose OK.
125When you restart Windows for Workgroups, Winpopup will load 

automatically.

Note: You may configure Winpopup to display a pop-up dialog box or 
sound when you receive a message. Consult your Windows documentation 
to configure Winpopup.

Configuring For Windows 95 

126Click Start, then point to Settings….
127Click Taskbar, then the Start Menu Programs tab.
128Click Add, and enter the following line: 

winpopup.exe

129Click Next>, then double-click the StartUp folder.
130Type the name that you want to see on the Startup menu, and then click

Finish.
131When you restart Windows 95, Winpopup will load automatically.
132
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Configuring For Windows NT 

133Open the Control Panel. Double click on the Services icon. The NT 
Services dialog box appears.

134Verify the Messenger Service is displayed in the services window.
135Highlight Messenger Service. If Start is highlighted, choose it. If Stop 

is highlighted, the Messenger Service is running.
136To make the Messenger service start automatically, click Startup… , 

then choose Automatic. Click OK.
137
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Exporting Statistics  
This section describes how to export session statistics, hourly port statistics, 
and daily port statistics in either delimited text format or dBase.

Exporting Statistics in Delimited Text Format
To export session statistics, hourly port statistics, or daily port statistics in 
delimited text format, do the following:

1. On the Tools menu, click the type of statistics (session, hourly port, or 
daily port) that you want to export.  The Export dialog box appears.

2. Choose Text (Delimited) in the Data Destination field.
3. Click OK.  The Export dialog box reappears.
4. Select the dates that you want statistics from in the Select Dates to Export

field.  The dates of the days having recorded statistics are listed in this
field.

5. Click OK.  The Export File Name dialog box appears.
6. Enter the name of the file to which the statistics will be exported or choose

one of the files listed.  The default file type is .txt.
7. Click Open.  The Export Options dialog box appears.  You choose the 

format for your export file from these options.  The options are the 
following:

·   Store Field Name in First Row  Allows you to include the field names 
in the exported file.

·   File Type field.  Controls whether the file uses the ANSI or the 
UNICODE character set.  The default is Windows (ANSI).

·   Text Delimiter field.  Determines the character that is used to show the 
beginning and end of a text string.  The default text delimiter is 
double quotes ( ² ).

·   Field Separator field.  Determines the character that is used to separate 
fields in the record.  The default field separator is a comma ( , ).

· Select the format of your dates, times, and numbers in the Dates, Times, 
and Number fields.  The options are the following:

·
·   Date Order.  Controls the order in which the day, month, and year are 

exported.  The default is month, day, year (MDY).
·   Leading Zeroes in Dates.  Determines whether or not elements of the 

date are padded with leading zeroes.
·   Time Delimiter.  Determines the character that is used to separate the 

elements of the time field.  The default time delimiter is a colon ( : ).
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·   Date Delimiter.  Determines the character that is used to separate the 
elements of the date field.  The default date delimiter is a forward 
slash ( / ).

·   Four Digit Years.  Controls the number of digits exported to designate 
the year.

·   Decimal Separator. Determines the character that is used to specify the 
location of the decimal point in numbers.

8. Click OK when you finish choosing the formatting options.
9. RAS Manager notifies you when the exporting is complete.

Exporting Statistics in dBase Format
To export session statistics, hourly port statistics, or daily port statistics in 
dBase format, do the following:

1. On the Tools menu, click the type of statistics (session, hourly port, or 
daily port) that you want to export.  The Export dialog box appears.

2. Choose dBase in the Data Destination field.
3. Click OK.  The Export dialog box reappears.
4. Select the dates that you want statistics from in the Select Dates to Export

field.  The dates of the days having recorded statistics are listed in this
field.

5. Click OK.  The Export File Name dialog box appears.
6. Enter the name of the file to which the statistics will be exported or choose

one of the files listed.  The default file type is .dbf.
7. Click Open.  The Export Options dialog box appears.  You choose the 

format for your export file from these options.  The options are the 
following:

· File Type field.  Controls whether the file uses the ANSI or the 
UNICODE character set.  The default is Windows (ANSI).

 Select the format of your dates, times, and numbers in the Dates, Times 
and Number fields.  The options are the following:

   Date Order.  Controls the order in which the day, month, and year are 
exported.  The default is month, day, year (MDY).

   Leading Zeroes in Dates.  Determines whether or not elements of the 
date are padded with zeroes.

   Time Delimiter.  Determines the character that is used to separate 
elements in the time field.  The default time delimiter is a colon ( : ).
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   Date Delimiter.  Determines the character that is used to separate 
elements in the date field.  The default date delimiter is a forward 
slash ( / ).

   Four Digit Years.  Controls the number of digits exported to designate 
the year.

8. Click OK when you finish choosing the formatting options.
9. RAS Manager notifies you when the exporting is complete.

Copyright Ó 1997 by NTP Software.  All rights reserved.50



Export Function Statistical Log Files
This section defines and explains the fields of the statistical log files created 
when you use the Export function.  It is possible to have six log files:  sessions
log files for delimited text format and dBase format, hourly log files for 
delimited text format and dBase format, and daily log files for delimited text 
format and dBase format.
RAS Manager stores up to 31 statistical log files.  You can increase or decrease
this value by using the registry editor on your primary RAS server and  
changing the value of the following field:

MaxAgedDays in HKEY_LOCAL_MACHINE\NTPSoftware\RASMgr.

Export Session Log File
The following table lists and describes the text and dBase field names and field
definitions for the Export session log files.

Field Name Field Definition
Text dBase

Authorized AUTHOCODE Contains codes describing the user’s 
access or restrictions.  The codes are:
0-- Authenticated.  Successfully  
connected.
1-- Not authenticated due to logon hour 
restriction.
2-- Not authenticated due to server 
access restriction.
3-- Not authenticated due to concurrent 
session limit.
4-- Not authenticated due to daily limit 
restriction.
5-- Not authenticated due to weekly limit
restriction.
6-- Not authenticated due to monthly 
limit restriction.

Start Date STRTDATE The date on which the connection began.
Start Time STRTIME The time at which the connection began 

(24 hour clock).
End Date ENDDATE The date on which the connection 

ceased.
End Time ENDTIME The time at which the connection ceased.
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Session 
Length

SESSLEN The number of minutes the session was 
maintained (minutes and decimal 
minutes).

Session Limits SESSLIM The maximum number of minutes 
allowed for this connection.  This value 
can vary depending on whether the 
connection is during peak hours or off 
hours.  0 means unlimited time.

Domain DOMAIN The name of the domain to which the 
user is connected.

User USER The user ID used to make the connection.
User Compt USERCN The name of the computer from which 

the user logged on.

TCP/IP Addr IPADDR The TCP/IP address assigned to the user 
when the connection is made using 
TCP/IP.

IPX Addr IPXADDR The IPX address assigned to the user 
when the connection is made using IPX.

NetBios Name NBNAME The NetBios address assinged to the user 
when the connection is made using 
NetBios.

RAS Compt RASCN The name of the computer to which the 
user logged on.

RAS Port PORT The port on the RAS Server the user.
Connect BPS CONNTBPS The speed of the RAS connection.
Multi-Linked PORTLINK If the value in this field is zero  (0), the 

RAS port the user is connected to is not a
multi-linked port.  If the value is one (1),
the port is multi-linked.

RAS Device 
Type

DEVTYPE The type of port to which the user is 
connected.

RAS Device 
Name

DEVNAME A text description of the port to which 
the user is connected.

BytesXmited BYTEXMIT The number of bytes transmitted during a
session.

BytesRcved BYTERCVD The number of bytes received during a 
session.

FramesXmited FRMEXMIT The number of frames transmitted during
a session.

FramesRcved FRMERCVD The number of frames received during a 
session.

CRC Errs CRCERR The number of cyclic redundancy check 
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errors in a session.
Timeout Errs TIMEOUTS The number of time out errors that 

occurred during a session.
Align Errs ALIGNERR The number of alignment errors that 

occurred during a session.
HwdOverrun 
Errs

HWDOVRUN The number of hardware overrun errors 
that occurred during a session.

Framing Errs FRMERRS The number of framing errors that 
occurred during a session.

BufOverun 
Errs

BUFOVRUN The number of buffer overrun errors that 
occurred during a session.

BytesXmited 
(uncomp)

BYTXMITU The number of bytes transmitted 
uncompressed.

BytesRcved 
(uncomp)

BYTRCVDU The number of bytes received 
uncompressed.

BytesXmited 
(comp)

BYTXMITC The number of bytes trasmitted 
compressed.

BytesRcved 
(comp)

BYTRCVDC The number of bytes received 
compressed.

Export Hourly Log Files
The following table lists and describes the text and dBase field names and field
definitions for the Export hourly log files.

Field Name Field Definition
Text dBase

Server SERVER The name of the RAS Server.
Port PORT The name of each port on the 

server.
Date DATE The day for which the hourly 

activity is recorded.
Hour HOUR The hour during which the activity 

is recorded (military time).
Active Connections UTILCNT The number of active connections 

during a specific hour.
Denied Connections FAILCNT The number of denied connections 

during a specific hour.
Utilization (min) UTILTIME The number of minutes a port was 

utilized during a specific hour.
BytesXmited BYTEXMIT The number of bytes transmitted 

during a specific hour.

Copyright Ó 1997 by NTP Software.  All rights reserved. 53



BytesRcved BYTERCVD The number of bytes received 
during a specific hour.

FramesXmited FRMEXMIT The number of frames transmitted 
during a specific hour.

FramesRcved FRMERCVD The number of frames received 
during a specific hour.

CRC Errs CRCERR The number of cyclic redundancy 
check errors in a session.

Timeout Errs TIMEOUTS The number of time out errors that 
occurred during a specific hour.

Align Errs ALIGNERR The number of alignment errors 
that occurred during a specific 
hour.

HwdOverrun Errs HWDOVRUN The number of hardware overrun 
errors that occurred during a 
specific hour.

Framing Errs FRMERRS The number of framing errors that 
occurred during a specific hour.

BufOverun Errs BUFOVRUN The number of buffer overrun 
errors that occurred during a 
specific hour.

BytesXmited 
(uncomp)

BYTXMITU The number of bytes transmitted 
uncompressed.

BytesRcved 
(uncomp)

BYTRCVDU The number of bytes received 
uncompressed.

BytesXmited 
(comp)

BYTXMITC The number of bytes transmitted 
compressed.

BytesRcved (comp) BYTRCVDC The number of bytes received 
compressed.

Export Daily Log Files
The following table lists and describes the text and dBase field names and field
definitions for the Export daily log files.

Field Name Field Definition
Text dBase

Server SERVER The name of the RAS Server
Port PORT The name of each port on the 

server.
HOUR Has no meaning for this file.

Date DATE The day for which the daily 
activity is recorded.

Copyright Ó 1997 by NTP Software.  All rights reserved.54



Successful Connections UTILCNT The number of successful 
connections for a specific day.

Denied Connections FAILCNT The number of denied 
connections for a specific day.

Connection Length 
(min)

UTILTIME The total number of minutes the 
port was in use for a specific day.

Session Limits SESSLIM The maximum number of 
minutes allowed for this 
connection.  This value can vary 
depending on whether the 
connection is during peak hours 
or off hours.  0 means unlimited 
time.

Domain DOMAIN The name of the domain to which
the user is connected.

User USER The user ID used to make the 
connection.

User Compt USERCN The name of the computer from 
which the user logged on.

TCP/IP Addr IPADDR The TCP/IP address assigned to 
the user when the connection is 
made using TCP/IP.

IPX Addr IPXADDR The IPX address assigned to the 
user when the connection is made
using IPX.

NetBios Name NBNAME The NetBios address assinged to 
the user when the connection is 
made using NetBios.

RAS Compt DEVNAME The name of the computer to 
which the user logged on.  

RAS Port PORT The port on the RAS Server the 
user to which the user connected.

Connect BPS CONNTBPS The speed of the RAS 
connection.

Multi-Linked PORTLINK If the value in this field is zero  
(0), the RAS port the user is 
connected to is not a multi-linked
port.  If the value is one (1), the 
port is multi-linked.

RAS Device Type DEVTYPE The type of port to which the user
is connected.

RAS Device Name DEVNAME A text description of the port to 
which the user is connected.
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BytesXmited BYTEXMIT The number of bytes transmitted 
daily.

BytesRcved BYTERCVD The number of bytes received 
daily.

FramesXmited FRMEXMIT The number of frames 
transmitted daily.

FramesRcved FRMERCVD The number of frames received 
daily.

CRC Errs CRCERR The number of cyclic redundancy
check errors daily.

Timeout Errs TIMEOUTS The number of time out errors 
that occurred daily.

Align Errs ALIGNERR The number of alignment errors 
that occurred daily.

HwdOverrun Errs HWDOVRUN The number of hardware overrun 
errors that occurred daily.

Framing Errs FRMERRS The number of framing errors 
that occurred daily.

BufOverun Errs BUFOVRUN The number of buffer overrun 
errors that occurred daily.

BytesXmited (uncomp) BYTXMITU The number of bytes transmitted 
uncompressed.

BytesRcved (uncomp) BYTRCVDU The number of bytes received 
uncompressed.

BytesXmited (comp) BYTXMITC The number of bytes trasmitted 
compressed.

BytesRcved (comp) BYTRCVDC The number of bytes received 
compressed.
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Chapter 4 Troubleshooting 
138
139
140Overview: The RAS Manager program is tightly integrated with 

Windows NT. This integration improves the isolation of potential 
problems that affect RAS connections. 

RAS Manager Event Posting
141
142Each RAS Manager “event” is posted to the application log:
143
144When the RAS Manager service starts or stops
145When a user logs on, or off the RAS server
146When a user is “forced” off due to imposed time limits
147When a user tries to log on during restricted logon hours or days
148When any internal programming problem occurs
149
150When problems occur, first check the application log. This information 

can point you to potential configuration problems: globally, or user 
specific.

151 

Support Information 
152If the problem persists, contact NTP Software at 603-626-0986. Leave a 

message and phone number when prompted. Someone from Software 
Support will return your call as soon as possible. Or you can contact NTP 
Software Support on-line at: http://www.ntpsoftware.com; email: 
support@ntpsoftware.com. Please have the following information 
available:

· Your RAS Manager serial number 
· Windows NT version and the list of services you are currently running
· RAS Manager application log information
· The specific problem(s) requiring assistance
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153Glossary
154
155Concurrent Sessions.  The number of concurrent user logons through 

RAS with the same user id. 
156Dial-in permission. Permissions (set in RAS Manager User Properties) 

that allow user(s) to connect to the network from a remote workstation. 
157
158Domain(s). A group of Windows NT servers that share common 

security policy and account databases. 
159
160Logon Hours, Default. The times and days that a RAS user can logon to

the network. Default Logon Hours apply when individual logon hours are 
not set in User Properties.

161
162Logon Hours, Individual. User specific times and days a RAS user can 

logon to the network. 
163
164Logon Server Access, Default. By default, all RAS users have access to 

all RAS servers. Logon Server Access lets the Administrator restrict 
global RAS access to specified servers.

165
166Logon Access to Specified Servers, Individual. Lets Administrators 

restrict  access to RAS servers on an individual basis. 
167
168Off Hours. The hours (day or night) that network demand is at a 

minimum. Any time that is not identified by the RAS Manager program 
as a peak hour is off hours by default. 

169
170Off Hour Time Limits, Default. Time limits imposed globally on RAS 

sessions during network off hours (as set in System Preferences). 
171
172Off Hour Time Limits, Individual Time limits imposed on individual 

RAS user sessions during network off hours (as set in User Properties). 
173
174Peak Hours. The hours (day or night) that your NT network has the 

greatest number of clients connected, using the greatest amount of 
network resources. RAS Manager has two time references: Peak Hours 
and Off hours.
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175
176Peak Hour Time Limits, Default. Time limits imposed globally on 

RAS sessions during network peak hours (as set in System Preferences). 
177
178Peak Hour Time Limits, Individual. Time limits set on individual RAS 

user sessions during network peak hours (as set in User Properties).
179
180Remote Access Server (RAS). A Windows NT service that lets users in 

remote sites use the network as if their computers were directly connected
to the network. 

181
182RAS User. An individual with a valid network I.D. that connects to the 

network from a remote location using the RAS service. 
183
184RAS Session. The total time (day or night) that an individual is 

connected to the network from a remote location using the RAS service. 
185
186System Preferences. Global default settings that apply to all RAS 

sessions. 
187
188User Properties. Individual settings for each RAS user. Once set, 

individual settings override system default settings. 
189
190Warning Messages. Custom messages that warn users of impending 

disconnection.
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default time limits
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granting, 40
dial-in permissions, 59
document window, 22
domain

selecting, 45
domains, 59
event posting, 58
Export daily log
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Export hourly log
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Export session log
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dBase format, 50
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log files, 52
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glossary, 59
individual logon access, 59
initializing the service, 9
installation, 7, 8

adding and removing components, 
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problems, 12
reinstalling, 10
uninstalling, 9

logon hours
default, 59
individual, 59

logon server access
default, 59

main window, 20
main menu, 21
title bar, 21
toolbar, 21

materials list, 6
off hour time limites

default, 59
off hour time limits

individual, 59
off hours, 59
on-line help

using, 26
peak hour time limits

default, 60
individual, 60

peak hours, 59
peak hours and off hours

setting, 34
product support, 58
RAS session, 60
RAS user, 60
remote access server (RAS), 60
remote access service (RAS), 14
restricting

dial-in permissions, 18
dial-in time limits, 19
logon access, 19
server logon access, 18

servers
restricting specified, 43

statistics log
Export daily, 55
Export hourly, 54
Export session, 52

status bar, 22
using, 26
viewing or hiding, 26

support
product, 58
technical, 58

system preferences, 16, 60
setting, 27

system requirements, 7
technical support, 58
tool bar
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using, 24
toolbar

user menu shortcuts, 24
viewing or hiding, 25

toolbar shortcuts
help menu, 25
options menu, 25

troubleshooting, 58
user, 41
user accounts

selecting, 38
user logon hours

managing, 41
user menu

changing default settings, 23
user properties, 17, 60

disabling, 43

resetting, 46
user RAS properties

setting, 37
user time limits

setting, 38
using on-line help, 12
warning messages, 13, 60

configuring for remote 
workstations, 46

setting, 36
Windows 95

configuring, 47
Windows for Workgroups

configuring, 47
Windows NT

configuring, 48
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